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Interactive PDF is dead—here’s what you can create from InDesign that’s even better
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It sounds like I’m exaggerating doesn’t it?

I’m not.

Almost none of the interactivity in an interactive PDF actually works, even in Adobe Acrobat and Adobe Reader.

What doesn’t work in a PDF

Here’s a list of things that you can create with InDesign that don’t work in a PDF:

	Animation
	Video*
	Animated GIFs
	Multi-State Objects
	Embedded HTML content (like YouTube videos)
	Button actions related to several of the above items
	Scrollable Frames
	Custom page transitions (like flipbook pages)
	Designer-controlled responsiveness


*Video was supported previously in Acrobat and Adobe Reader, but it was dependent on the Flash Player (which no longer comes bundled with the Adobe apps).

The introduction of smartphones and tablets—almost none of which now support Flash—and a slew of new PDF readers, essentially guarantee that interactive PDF features will not work when your clients view your PDFs.

To see the breakdown of an interactive PDF in action, and to get a sneak peek at the solutions that I describe below, you can watch the following video.



Here’s what you can switch to today that supports interactivity

HTML. It’s the language of the web page that you’re reading right now.

HTML has all of the same layout capabilities that PDF does and has a much greater interactive capacity.

Remember the list of interactivity from above?

	Animation
	Video
	Animated GIFs
	Multi-State Objects
	Embedded HTML content (like YouTube videos)
	Button actions related to several of the above items
	Scrollable Frames
	Custom page transitions (like flipbook pages)
	True responsiveness (some PDF reader do automatic adjustments on small screens)


HTML supports all of them (and more).

Don’t know how to (or don’t care to) write HTML? Not a problem.

InDesign can export it for you.

How to create interactive HTML from Adobe InDesign

I’ve detailed three ways to export HTML from InDesign (included in the video above as well).

	Fixed Layout (FXL) EPUB
	Publish Online
	in5 (InDesign to HTML5)


Each of these solutions is HTML at its core.

Creating the interactivity with InDesign

It’s rather straight-forward to create interactivity with InDesign.

The tools are visually-oriented and easy-to-use, so you don’t have to know any code.

	Video and animated GIFs can simply be placed in InDesign using File > Place.
	HTML embeds (like YouTube, Google Maps, Twitter feeds, etc) can be pasted onto the page or inserted via Object > Insert HTML.
	Animation, Button actions, and Object States can be created with InDesign’s built-in panels.
	Scrollable Frames are supported via the Universal Scrolling Frames panel.



For step-by-step lessons on how to create interactivity with InDesign, check this free course on Becoming a Digital Publishing Master.

Get the free course



If you want to go even deeper into interactivity beyond a PDF, including with example files, check out the Creating Your First Interactive Document video course.

Any of the HTML options in this article will then export this InDesign-based interactivity, so let’s look at each of those options in more detail.

Creating a FXL EPUB

An EPUB is essentially a zipped-up folder of HTML that can read by an EPUB reader app (like Apple iBooks or Adobe Digital Reader).

It’s typically used for ebooks.

InDesign lets you export FXL EPUB via File > Export.

Pros of FXL EPUB

The EPUB is the only HTML option that produces a single distributable file (an .epub) that can be (fairly) easily read like a PDF.

This makes it easier to email your digital content and, in some cases, easier to sell your content in a marketplace (such as the iBooks Store).

Cons of FXL EPUB

EPUB readers are inconsistent in what they support.

iBooks, for example, has a habit of blocking outside content (or even inside content that appears to be outside content).

The reader app controls the page transitions and the overall experience.




If you want to see more about how EPUB and other formats compare, check out the free Digital Publishing Technology Guide.

Get the Guide



Using Publish Online

Publish Online is a “technology preview” from Adobe. It’s been in “preview” mode since 2015, so the future of this option is unclear, but it is super easy to use.

The quick and simple nature makes Publish Online a great tool for client and internal review.

Pros of Publish Online

It’s push-button publishing. With a single step, your interactive document is sent to Adobe’s servers and you’re given a URL (web address) where your content can be viewed online.

Cons of Publish Online

Publish Online content only lives on Adobe’s servers. You cannot put it directly on your site (though you can embed it inside of a container).

Adobe can choose to remove or alter your content at any time.

Since you don’t have access to the files, you also cannot customize them in any way.

Similarly, you cannot repurpose the HTML or convert it to a mobile app (which you could easily do with the actual HTML files).

Your Publish Online link is essentially private unless you choose to share it (though you cannot password protect it), which means it’s also not exposed to search engines, so it won’t appear in a Google search, or improve the SEO (Search Engine Optimization) of your site like HTML hosted on your own site would.

Publish Online uses the same underlying FXL export, which means it has some of the same underlying bugs, like the Object State rollover bug shown in the video above.

See also: our full comparison between in5 and Publish Online.

Creating HTML that you own with in5



in5 (InDesign to HTML5) is a 3rd-party add-on to InDesign created by Ajar Productions. It lets you export interactive content without writing any code, and it lets you host it anywhere.

Once installed, you can export from within InDesign using File > Export HTML5 with in5…

in5 exports HTML to your local computer, so you can do anything that you want with it.



Pros of in5

Unlike Publish Online, with in5, you own the files that you export. You can put them on your own web servers.

You can also customize the files as much as you would like and you can create mobile apps from your in5 output.

in5 also offers a huge amount of flexibility with several push-button customizations like flipping pages for digital magazines, responsive layouts, and additional interactive options like 3D Flip Cards.


You can test drive in5 for free.

Get in5 now



Cons of in5

in5 is a commercial tool, so there is an additional cost to use it (in5 pricing page).

Unlike Publish Online, in5 doesn’t automatically upload your content to the web, so you’d have to take this step yourself.

Bonus option: hacking Adobe’s FXL export

If you like the free price tag of Publish Online, but want more freedom with the files, check out Keith Gilbert’s free script, which uses the underlying FXL export to save your files as local HTML. It’s not as fully-featured as in5, but very handy if your project has no budget.

Which digital publishing option is best for your project?

PDF is still a great format for static documents, but if you want interactivity; take a long, hard look at the HTML-based options that I’ve outlined above.




If you need more information about which digital publishing option best fits your project, check out the free Digital Publishing Technology Guide.

Get the Guide
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		52 replies on “Interactive PDF is dead—here’s what you can create from InDesign that’s even better”		

			

				
				
				
						judblakely says:		

		
		
			April 5, 2018 at 10:12 am		


		Justin, in5 is a brilliant tool for getting the most out of any on-line publication.  To me, in5 amounts to kind of a “magic Swiss Army knife” that is about as easy to grasp and apply as a magic Swiss Army knife can be.  Your brief tutorials hit the necessary bull’s-eyes without fail and have zero fat.  They are as enjoyable to watch as they are valuable in what they provide a viewer.  Keep on keepin’ on.


		
				

					
				
				
						Justin says:		

		
		
			April 6, 2018 at 6:50 am		


		Thanks, Jud! Really appreciated it. 🙂


		
				

				



	
				
				
						David Bell says:		

		
		
			April 9, 2018 at 11:56 am		


		Very, very helpful…thank you.


		
				

					
				
				
						Justin says:		

		
		
			April 9, 2018 at 12:55 pm		


		Glad to hear it, David! 🙂


		
				

				



	
			
				Pingback: This Month in InDesign Articles, April 2018 - InDesignSecrets.com : InDesignSecrets 			

		
	
			
				Pingback: Create Awesome Slides from InDesign using in5's Presentation Mode 			

		
	
				
				
						Harish Chauhan says:		

		
		
			July 9, 2018 at 10:51 am		


		Thanks Justin, 

This was an informative article. As the co-founder of InteractivePDF.com I do agree with its limitations but there is huge opportunity for iPDF documents especially in the Learning and Training industry – iPDFs provide exceptional learning support for people who need immediate access to large amounts of information to learn a new software system like SAP for example. In this case we have developed iPDF solution that can help all staff learn what they need to know on how to use SAP for their new job. 

So iPDFs are NOT Dead. They are just not a silver bullet for all things interactive. 

But we all must see what solves the problem we are looking solve in the best way. 

Hope we can continue this dialogue. Thanks again for the article.


		
				

					
				
				
						Jud Blakely says:		

		
		
			July 9, 2018 at 11:02 am		


		This seems to be a reply of integrity from someone with a persuasive case to make for interactive PDFs.  All I can say is, please make the case, which I believe is quite likely to reinforce your view that interactive PDFs are either dead or dying.


		
				

				
	
				
				
						Justin says:		

		
		
			July 11, 2018 at 8:22 am		


		Hi Harish,

My guess is that the value to your customers (and thus the opportunity) is in the content that you create, and not than the Interactive PDF format itself.

If you were to rebrand away from a format that’s interactivity is based almost entirely on the Flash Player, you could provide your customers with even more value by delivering in the format that best suits their project (rather than being bound to a dying technology—though you may occasionally still deliver PDFs). This would open up new interactive possibilities, and let you serve your customers better, instead of working with both hands tied behind your back. 😉


		
				

					
				
				
						Quintin Smith says:		

		
		
			April 27, 2019 at 7:33 am		


		Of note, the interactivepdf-dot-com company has rebranded or they’re no longer in business and returning calls. Thank you for this article on what is possible beyond interactive PDFs.


		
				

				






	
				
				
						Sam says:		

		
		
			August 12, 2018 at 6:07 am		


		Does in5 allow exporting of the HTML to a portable container format including all content that can be easily emailed and opened by the recipient? Can this document also be printed?

In other words is it possible to create an equivalent to flash based interactive PDF’s yet, and if not why get rid of flash without a replacement?


		
				

					
				
				
						Justin says:		

		
		
			September 5, 2018 at 8:31 am		


		Flash was gotten rid of in the rise of Apple iOS, which didn’t support it.

HTML can be zipped, then unzipped on the other end, but I recommend sending via Dropbox (Box, Drive, or similar) as a shared link instead of attaching because some email clients block attachments that contain JavaScript.

The Viewer Display options let you include a PDF for printing. More info:

https://ajarproductions.com/blog/2017/09/11/viewer-display-options-control-bar-in5-v3-1-sneak-peek/


		
				

					
				
				
						Sam says:		

		
		
			September 29, 2018 at 8:22 pm		


		Hi Justin,

I don’t think a zip file containing html is the way forward to distribute documents via email, as clicking on a link or opening a zip file is not the same as opening a portable document format.

Adobe need to use it, if the organisations’ goal is to lose it then InDesign is relegated to print and Adobe don’t have a viable future.

In terms of export from In5 to html will kerning of twins/triplets/ letter pairs carry over to exported html for publishing? I ask as this is one way Adobe might stay relevant.

Sincerely,

Sam


		
				

				
	
				
				
						Justin says:		

		
		
			October 3, 2018 at 9:09 am		


		HTML does not support kerning pairs (as far as I know) at this time. There is always the option to render text as images to preserve these specifics. I don’t think the web will ever be as concerned with typographic details as a print design application.


		
				

				






	
				
				
						Sam says:		

		
		
			September 4, 2018 at 10:17 pm		


		Thank you Justin. This has been a really great help.


		
				

					
				
				
						Justin says:		

		
		
			September 5, 2018 at 8:28 am		


		Glad to hear it, Sam. 🙂


		
				

				



	
				
				
						wiki baba says:		

		
		
			September 26, 2018 at 6:29 am		


		thanks justin for such details………..


		
				

				
	
				
				
						Emma says:		

		
		
			September 28, 2018 at 1:48 pm		


		I want to design a PDF file which enables me to write some data in it. In other words, I want to design a PDF and I want to add some objects in it like “TEXT BOX, CHECK BOX, RADIO BUTTON, ETC”

and at the end of the page I want to add a button which enables me to send this document to specefic email which I can select or I want this button to enable me to print this document.

How can I do that ? any ideas ?

Thanks


		
				

					
				
				
						Justin says:		

		
		
			September 28, 2018 at 2:23 pm		


		That’s a bit far afield from the content of this post. Check out a Linkedin Learning course on PDF Form Elements.


		
				

				



	
				
				
						Sam says:		

		
		
			September 29, 2018 at 9:04 pm		


		Adobe have to make the same decision as when InDesign was conceived, I think we need a new (well funded and resourced) transparent (for community development purposes) publishing and design environment which allows export to multimedia.

It can still be called InDesign. 

• html

• PDF including html+css+js/as wrapper for distribution

• PDF for print from the same file as the last point.

• A transparent script editor

• InDesign kerning on html/pdf wrapper export

• Some new methods of setting up character/paragraph styles and also on the corresponding html + css export using units set as required e.g. ems/mm/px/points/vw/vh/pw/ph/% (and so on) for dimensions and also with additional control over the values depending on user set document variations = Custom responsive breakpoints set by the designer as required on all page, typographical and content dimensions.


		
				

				
	
				
				
						Don says:		

		
		
			October 25, 2018 at 2:44 pm		


		Great plugin! BUT WAY TOO EXPENSIVE. please lower cost.


		
				

					
				
				
						Justin says:		

		
		
			October 25, 2018 at 2:47 pm		


		Hi Don,

Glad you like the plugin!

Sorry, but I’m not planning to lower the cost. You can always get a monthly plan and cancel when you’re done. 🙂


		
				

				



	
				
				
						John Frederick Chionglo says:		

		
		
			October 26, 2018 at 7:57 pm		


		Justin (2018) lamented the loss of some interactive objects that can be created in InDesign and exported to an interactive PDF. The losses do not mean interactive PDFs are a dying or dead breed. A PDF form application that uses JavaScript and the Acrobat/JavaScript API is an interactive feature still available in PDF and supported by Adobe Acrobat. It can be used to replace some lost interactive objects and more.

It is possible to create interactive objects in InDesign and to export them as PDF form applications. If you require an interactive object in an interactive PDF but it is unavailable then it may be worthwhile to include software development in your workflow to give your InDesign user the ability to create the interactive object in InDesign and export it as a PDF form application. With a PDF form application that use JavaScript and the Acrobat/JavaScript API it is possible to combine unique visual graphics with innovative interactive features for novel user experiences. The interactive PDF version of “InDesign Interactive Objects as PDF Form Applications” includes examples of PDF form applications — please check out the following URL:

https://www.slideshare.net/JohnChionglo/indesign-interactive-objects-as-pdf-form-applications.


		
				

					
				
				
						Justin says:		

		
		
			October 31, 2018 at 8:13 am		


		Hi John,

1) InDesign doesn’t export all interactive objects to PDF (see the article above).

2) As you mention, JavaScript in a PDF only functions in Acrobat (and probably only on the desktop). One of the main issues described in this the proliferation of mobile devices and non-Adobe PDF readers. That is still a major problem (coupled with the fact that most people creating PDFs are not able to custom program them–nor would they want to even if they could).

While there might be some .001% of use cases where injecting JavaScript into a PDF saves the day, it’s not what 99.999% of people are looking for when they create/refer to an interactive PDF.

There is a place where JavaScript roams free and dynamic content can be easily created and both work on nearly every device…it’s called the web.

I still think there are great uses for PDF that I couldn’t live without, but PDFs are not a good delivery mechanism for true interactivity (for all of the reasons listed in the article above).


		
				

				
	
				
				
						critic says:		

		
		
			February 5, 2019 at 9:11 am		


		To a man with a hammer everything looks like a nail…

PDF interactive forms are far from dead.  For proof you only need to look at PDF417 barcoding as it works in conjunction with the fillable PDF forms and PDF signatures.  A search for a tool designing these types of documents brought me here, but I am miffed because “even better” referenced in the title of this post is simply a car salesman’s puffery.


		
				

					
				
				
						Justin says:		

		
		
			February 5, 2019 at 9:17 am		


		I would agree with you that forms and signatures are still a great use for PDFs (of which there are many). Note that most of the services that let you digitally sign a PDF online are actually rendered with HTML so that they can be viewed consistently on all browsers without the need for a plugin. 😉


		
				

				






	
			
				Pingback: How to Create an Animated GIF with InDesign (& in5) 			

		
	
				
				
						Alan Potkin says:		

		
		
			May 11, 2020 at 4:58 pm		


		Suggest that you look through my website, of which the interactive content is completely based on PDF and Flash, and which has —as you point out— become almost unusable. For the moment, it still works, though, if you read and obey this online advisory… 


		
				

					
				
				
						Justin says:		

		
		
			May 12, 2020 at 6:09 pm		


		That’s a big hurdle.


		
				

					
				
				
						Alan Potkin says:		

		
		
			May 13, 2020 at 2:17 am		


		what, exactly is the big hurdle? Unfortunately your comment software strips out any attempt —so it appears— to include URLs, so the online advisory of what was entailed to get our eBooks to open and run interactively, in full accord with our authoring style, did not appear the last time I used this box. Yes, I know all about what’s happened to interactive PDF under most modern browsers, and I contacted you in search of a plausible work-around; other than my generally ignored instructions on how to access the substantive linked material using IE v. 11 on the PC platform, or Firefox on both PCs and Macs. Here, I’ll give it another shot… https://cultivateunderstanding.com/Digital_Media/browser_config_instructions.pdf but if this comes up as a blank hole once again, maybe try Googling “browser_config_instructions.pdf”


		
				

				
	
				
				
						Justin says:		

		
		
			May 13, 2020 at 8:23 am		


		Asking people to read a long set of instructions to tell them to use different software, software that might be obsolete, is a big set of hurdles.


		
				

				
	
				
				
						Alan Potkin says:		

		
		
			May 13, 2020 at 12:54 pm		


		I’ve tried seeral times downloading and running the installer Mac in5 installer, to see in the demo version what it might do for me. When I do, the only installation option it gives me is to “install for ID2018”. I’m actually running IDCC2019CC, which works fine. No way, apparently, to change your installer to IDCC2019. (Indeed I can’t open or run IDCC2018, which is still listed amongst my applications.) Now what?


		
				

				
	
				
				
						Justin says:		

		
		
			May 13, 2020 at 1:28 pm		


		Hmm…perhaps there’s an issue with the 2019 installation. Reinstalling would probably fix that, but there are some simple options in the README.txt file.


		
				

				
	
				
				
						Alan Potkin says:		

		
		
			May 13, 2020 at 2:57 pm		


		Got it to start working on my alternate main workstation. Thanks, Justin for your patience with me. Id like to either chat or to send to you a back-channel email (to long for putting in this public space?) about where I’m coming from and what I need to do: both in reworking my 100+ gigs (!) of existing interactive PDF eBooks, and in creating new eBooks that will cut the mustard with present browsers and the imminent termination of Flash *.swp materials.


		
				

				
	
				
				
						Alan Potkin says:		

		
		
			May 13, 2020 at 3:03 pm		


		mean to say, “imminent termination of Flash *.swf materials.”


		
				

				
	
				
				
						Justin says:		

		
		
			May 13, 2020 at 3:13 pm		


		No problem, Alan. You can reach out directly here:

https://ajarproductions.com/pages/contact.php


		
				

				






	
				
				
						Alan Potkin says:		

		
		
			October 15, 2020 at 1:05 pm		


		Deleted from my comment yesterday’s textbody was the URL for the Cultivate Understanding website. The full material content —most of which is in interactive PDF—will come up fine if you click on my name in yellow.


		
				

					
				
				
						Justin says:		

		
		
			October 19, 2020 at 5:30 pm		


		I think it’s cool that you’re able to use that JS-based solution to render PDFs. However, I mostly see hyperlinks on your site. The point of the article above is that most designers would not consider hyperlinks alone to be highly interactive. Am I missing something on your site?


		
				

					
				
				
						Alan Potkin says:		

		
		
			October 19, 2020 at 7:15 pm		


		T thought that hyperlinks were what what interactive PDF was based upon. Either way, every image on the site —beyond the HTML homepages (and the .mp4 videos)— when clicked on shoul open up new material… largely in PDF, but not exclusively. What platform/OS are you using, and what browser? (Generally my stuff works most assuredly in Firefox or Safari.) The Shockwave/Flash *.swf interactive stitched cylindrical VR panos usually require the installation on the PB platform of Flash Player, and maybe also Flash Debugger. Knock yerself out, Justin!


		
				

				






	
				
				
						Justin says:		

		
		
			October 20, 2020 at 5:01 pm		


		You might want to re-read the article and take a look at the kinds of interactivity that people are creating with InDesign & in5:

https://ajarproductions.com/pages/products/in5/showcase.php

They include Multi-State Objects, Animation, Video, and more.


		
				

					
				
				
						Alan Potkin says:		

		
		
			October 21, 2020 at 9:35 am		


		Justin… No doubt many kewl things don’t play well with PDFs, but for the life of me I cannot imagine and substantive, illuminating us of multistate objects (whatever they are), animations, GIFs, blah blah blah in what I’m trying to accomplish as a content provider, primarily, working mostly on enviro and cultural conservation, and a self-taught developer of unorthodox usages of powerful, pedagically effective, and intellectually engaging visualization in technical documentation, which is usually dry as dust. Again, I can’t quite tell to what degree you’ve successfully gotten my material to open and run fully consistent with our authoring style, but it works on Chrome (except Chrome wants to download Flash/SWF files onto the end users HD, but they will work OK from there). Under Safari, the “websites general reader” check box has to be set to off, for cultivate understanding; and under Firefox prefs “general applications PDF” has to be set to “open in Firefox” (not in Adobe Reader, which is totally counter-intuitive!). Yeah I know, but if you saw the conventional alternative respectable, peer reviewed academic publication (e.g., this published online just today by a friend and colleague for which the URL, which will probably be scrubbed here tandfonline dot-com-/doi/full/10.1080/03066150.2020.1824181, you’ll see what a transformative leap I’m trying to offer.


		
				

				



	
				
				
						tiffani says:		

		
		
			November 12, 2020 at 10:27 am		


		we are using in5 for a publication that can be personalized. we would like an easier method. currently we publish about 30+ versions of the same publication to just change 2 pages. The problem is sometimes there are errors in the original publication and then we have to go back and update all 30+ versions. This is a huge hassle. Any solution?


		
				

					
				
				
						Justin says:		

		
		
			November 12, 2020 at 11:17 am		


		Hi Tiffani,

We can help you brainstorm some ideas. Please email us here:

https://ajarproductions.com/pages/contact.php?category=in5


		
				

				



	
				
				
						Michael Plastiras says:		

		
		
			January 7, 2021 at 1:57 am		


		Can I save my Indesign animation as Mp4 video with In5?


		
				

				
	
				
				
						Stefan Reuter says:		

		
		
			February 17, 2021 at 5:45 am		


		Hi Justin,

looks like I am too late: I want to use my old interactive pdf showing slides with voice over. It was created with Adobe Presenter 7.0 and Adobe PDF Library 8.0.

Is there a way to migrate/export/publish, allowing me to watch and share the content?

Right now it is just a white screen with warning that Adobe Flash is required – and not supported any longer.

Any advice?


		
				

					
				
				
						Alan Potkin says:		

		
		
			February 17, 2021 at 8:45 am		


		Yo, Stefan (and hi, Justin, whose parade I don’t want to rain on here). Since shortly after Adobe Systems released full Acrobat v. 1.0 in 1993 (!) I published extensively —originally in digital media and later online, mostly insanely interactive eBooks— almost exclusively in PDF. With all due modesty, I believe I more or less invented the interactive PDF eBook format, but when Apple mandatorily changed their Safari browser ayear or so ago to no longer run PDF in native format (likewise when MS dumped Internet Explorer!) I was seriously and severely screwed… until Leon Atherton of IDR Solutions in the UK came up with a brilliant work-around. 

As I’m unfamiliar with Presenter and PDF Library, which you imply outputs entirely in Flash, I don’t know if Leon’s fix would be workable. Encourage you to look through my primary website (which now opens and runs on any OS, any platform, and any browser…including hand-helds in IOS and probably Android). Ajar’s approach is excellent, but my problem is that I generally discarded the In-design layout files because once I had converted them to PDF, I constructed all the interactivity within PDF using full Acrobat. I have several hundred gigs of content  that I cannot back-engineer using Ajar’s apps since the ID files are long gone. 

I also got royally screwed by Adobe anathematizing Flash, since over the last two decades (starting just after Apple orphaned without warning their ground-breaking  QuickTime VR app),  I’ve produced dozens of stunning stitched cylindrical virtual reality panoramas in Shockwave/Flash *.swf. Seeing the grim future, I downloaded from Adobe their fully kosher installers for Flash Player and Flash Player de-Bugger in several bversions for the PC and Mac Platforms, and once run on anybody’s workstation’s HDDs, Flash content once again runs fine. But most unlikely they are still available anywhere online, and probably can only be provided on USB thumb drives or optical media disks by those of us that have them archived,  

Of course if your workstation is online, Adobe sniffs it out, they’ll try to get you to uninstall it, but they can’t make that happen unless you agree the run the Flash uninstaller app: a new copy of which they’ll kindly send to you every time. Just trash it whenever they try again. Quels batards!


		
				

				



	
				
				
						Anna says:		

		
		
			March 15, 2021 at 11:07 am		


		Hi There,

I took your advice above and created a FXL EPUB file and published my interactive PDF online. The buttons seem to work now, but my text boxes do not now. Do you have any advice for this problem?


		
				

					
				
				
						Justin says:		

		
		
			April 8, 2021 at 6:03 pm		


		I think you’re going to run into issues like that with both FXL EPUB and PDF formats. What are you using the textfields for?


		
				

				



	
				
				
						Marty Karr says:		

		
		
			May 19, 2021 at 3:14 pm		


		@ Alan Potkin

Are you by chance the same Alan Potkin  associated with NIU? If so, can you provide me the URL of your website in which event I’m hoping it has a contact email as I would very much like to  correspond with you regarding interactive PDF forms. Thank you ahead of time. I hope Justin of Ajar Productions will not be offended by my using the comment section to post this request.


		
				

					
				
				
						Alan Potkin says:		

		
		
			May 19, 2021 at 5:36 pm		


		Thanks,  Marty, yeah I’m the one.  I’ve been telling Justin for a year now that interactive PDF is far from dead, so I think he won’t take much offense at this hijacking of his comment thread. The info you wanted is below. I’m pretty much holed up in DeKalb IL these days, although COVID is a non-issue, generally, in these parts, but I haven’t been able to do any serious international travel and research for 17 months now. Arrggghhh. Where are you and can you recollect where and when did you encounter me and or my works? Since my university email won’t get published here, you can alternative try reaching me this way…. hanoiparishilton@gmail.com


		
				

				



	
				
				
						Harold Burton says:		

		
		
			June 1, 2021 at 3:05 am		


		As always, a very useful and entertaining video. Nice job! I can’t remember if you’ve ever talked about whether there are any extensions that will darken the text on webpages. A lot of them have text that is a light gray instead of black, and with my poor vision I have trouble reading them.


		
				

				
	
				
				
						Video And Animation Services says:		

		
		
			September 28, 2021 at 3:37 am		


		Very informative and good article. Thank you very much!


		
				

				


					
				
Comments are closed. Still have questions?
Contact Ajar 			
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